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Introduction

Introducing ACID Style
Pat yourself on the back: you are now in possession of the most revolutionary
piece of software available for Windows! Stockpile food around the computer
and take one last trip to the bathroom, because once you experience Sonic
Foundry’s ACID Style, you won’t be able to pull yourself away.

ACID Style is an amazing new tool that makes the production, arranging and
editing of loop-based music easier than ever before. ACID Style allows you to
take the tedious hours of Loop and sample matching out of the music-making
equation and opens the doors wide for creativity.

Using this Manual
In developing ACID Style, one of our primary goals was to make the interface
as easy to use as possible. However, some features may not be immediately
apparent, so we hope you take some time to at least page quickly through the
manual.That way, you won’t miss any of ACID Style’s creative potential.

The manual is separated into five major chapters: Introduction, Quick Start,
ACID Style Tutorial, ACID Style Reference, and Frequently Asked Questions.
These chapters are explained in greater detail below:

Introduction
This section contains information for installation and online registration.

Quick Start
This section contains the basic information for those who like to learn by
experience. This section will get you going, but we recommend that you look
at the other sections of this manual at some point so as not to miss any
important features.
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ACID Style Tutorial
This section contains a “how to” approach to using ACID Style.You’ll probably
want to start here to learn everything there is to know about ACID Style.

ACID Style Reference
This section contains descriptions of each control in ACID Style. Check here to
answer specific questions like, “I wonder what that button does?”.

Frequently Asked Questions
This section offers answers to some of the more frequently asked questions
about ACID Style.

Getting Started
Thank you for purchasing ACID Style and for your continued support of Sonic
Foundry products.

The first thing you should do is to register ACID Style by filling out the
registration card and returning it to Sonic Foundry within 30 days of
purchase.You will also be given the option to register online via our web
site at the end of the installation process, if you prefer.

You must be registered for us to provide you with technical support and
upgrade information.Also, we want to be able to let you know about additional
products and updates as they become available.
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System Requirements
In order to use ACID Style, you must have a computer equipped with the
following:

• Pentium 133 microprocessor or Alpha AXP microprocessor

• Microsoft Windows 9x or Windows NT 4.0 or later

• Windows-compatible sound card

• VGA display

• CD-ROM drive

• 32 MB RAM

• 5 MB hard-disk space for program installation

Installation
To install ACID Style on your computer, you need to run a program called
SETUP.EXE, which you will find on the ACID Style CD. As with most Windows
setup utilities, this program automatically creates any necessary directories and
copies all files required by ACID Style to your computer.

ACID Style requires Microsoft DirectX Media 5.2a or higher to be
installed on your computer.The setup program will notify you if it does
not detect DirectX Media 5.2a or higher on your computer, and will
prompt you to install it from the ACID Style CD-ROM.

Here’s all you need to do to install ACID Style:

1. After you place the ACID Style CD-ROM in the CD-ROM drive, AutoPlay
launches an installation menu. Press Install and follow the instructions that
appear on your screen.

If you have disabled the CD-ROM AutoPlay feature, type “Setup” from the
Run option in the Windows Start menu by typing E:\SETUP, where E is the
letter of your CD-ROM drive. Press Install and follow the instructions that
appear on your screen.
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There are hundreds of sample Loops on the ACID Style CD-ROM that
will not be installed when you install the program. If you want them on
your hard drive, you can manually copy them to a directory after the
installation process.This is convenient, but uses disk drive space. If you
have limited disk space, or just don’t want to add unneeded files to your
hard drive, you may simply use them off of the CD-ROM.The choice is
yours.

2. Next, you’ll be asked to enter registration information, including your serial
number.This number can be found on the registration card inside the front
cover of your ACID Style Quick Start Guide. You must have this serial
number whenever you run the Setup program.

ACID Style does not come with copy protection, other than requiring your
serial number when you run the Setup program. We feel that it is in your
best interest that the programs we sell not come with heavy-duty copy
protection.We hope you will allow us to continue this policy by abiding by
the license agreement and giving your friends our phone number, rather
than a copy of the software.

3. Select a destination to install ACID Style.To use the default location, click on
the Next> button.

4. Click Next> to install the ACID Style files.

Online Registration
During the installation process, you are given the option of registering online.
If you choose this option, the setup program will attempt to connect you to
your Internet Service Provider and open the Online Registration page on our
web site (http://www.sonicfoundry.com). Please enter the user and survey
information and press the Submit Form button at the bottom of the page.

If you choose not to register at the end of the setup process, you may register
at any time using the Online Registration page on our web site at
http://www.sonicfoundry.com/register. Or, if you prefer, complete the
registration card included inside the front cover of the Quick Start Guide, and
drop it in the mail.
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Configuring Your ACID Style System
Once you have installed your ACID Style files, you may want to set some system
options.These options are found on the Preferences window, which is accessed
by clicking on the Options menu, followed by the Preferences menu option.
The options on the Preferences window are explained in detail in the “ACID
Style Reference” chapter. However, if you’re new to making music, you may just
want to familiarize yourself with ACID Style and what it can do for you. In this
case, you’ll probably want to just continue on with the “Quick Start” or “ACID
Style Tutorial” chapters. It’s entirely up to you.

Technical Support
If you experience problems while using ACID Style, our technical support
department is always ready to help you.

Before You Call
Since we have many users, we ask that you do the following before calling:

• Make sure you have registered online or sent in your registration card.

• Check to see that the information you need is not already contained in the
manual or available in ACID Style’s Help file.

• Have your serial number and the type of hardware and software you are
using available to you.

• Use a phone that is near your computer so our support people can step you
through any problems.

Reaching Technical Support
For technical support you can reach us via any of the methods below.

Phone

Call us at (608) 256-5555, between 8:00 am and 7:00 pm CST, Monday
through Friday

Fax

Send us your questions via fax at (608) 256-7300, 24 hours a day.
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Email

Our email address is support@sonicfoundry.com.

Web

Our web site provides program updates, technical information, and support.
Our URL is http://www.sonicfoundry.com.



Quick Start

Welcome to Sonic Foundry’s ACID Style! This Quick Start section will have you
making music faster than you can say “ACID Style.” Use this section if you
already think you know what you’re doing (or at least you know your way
around ACID Style). If you don’t know what you’re doing, you’ll probably want
to skip this section for now (you can always refer to this section later!), and
move on to the “ACID Style Tutorial” section of this manual.

Finding Loops in the Media Explorer
The first thing you have to do to use Loops in a piece of music is to add them
to the Track List.To understand why, think of the Track List as your palette: the
place where you put the paint colors you are going to use to create your work
of art. Once the Loops are in the Track List, you can apply them to your audio
masterpiece. (Getting a little thick, isn’t it?)

Anyway, there are two ways to add Loops to the Track List.The easiest way is to
use the Media Explorer at the bottom of the ACID Style window. From there,
you can browse your local computer or network computers to find files.There
are a number of sample Loops on the ACID Style CD if you do not have any
Loops of your own.

Clicking on a file in the Media Explorer will automatically begin a preview of
the Loop at the current tempo.You can stop the preview by pressing the Stop
Preview button in the bottom left corner of the Media Explorer, or completely
disable the preview feature by unchecking the Auto Preview checkbox.
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Arranging Loops in the Track View
Once you have found a Loop you wish to use, you can add it to the Track View
by double clicking on it or dragging it into the Track View.To add Events to the
Track, use the Draw tool and draw across the empty Track.

As you draw, you will notice colored waveform data being displayed.This data
is the Loop you chose being drawn as if it were being duplicated, end to end
on the Track. The little black indents along the top and bottom of the Event
indicate where the Loop repeats itself. Using this technique, you can draw
Events anywhere in the Track.

Continue to add more Tracks and you are already creating your first ACID Style
tune.You can add up to 8 tracks.

If you discover that you’re addicted to ACID, and 8 Tracks just aren’t
enough, consider upgrading to ACID Music, which allows you to add an
unlimited number of Tracks. Contact Sonic Foundry or your ACID
distributor for more information.

Listening to Your Creation
Press the Play button in the Toolbar above the Track View, and ACID Style will
begin playback from the current cursor position. To play the entire project,
regardless of where the cursor is positioned, press the Play All button.

If you want to change the tempo of the project, move the Tempo slider below
the Track List.This can even be done in real time as the project is playing.

There is time compression and expansion being done on all of the loops to
match the project tempo.While the algorithm is very good, there are still
some limitations.You will probably not be able to get a 120 bpm Loop to
sound great at 60 bpm.
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ACID Style Tutorial

This section is devoted to taking a detailed look at the various features of ACID
Style.The topics covered are:

• Explaining the Paradigm

• Getting Around in the ACID Style Window

• Using the Media Explorer

• Basic Editing in the Track View 

• Editing the Track List

• Recording

• Setting Track and Event Properties

• Advanced Track Editing

Explaining the Paradigm
ACID Style is a real-time, Loop-based arrangement tool. The power of ACID
Style stems from its ability to take any audio Loop and make it fit into the
tempo of a project. You no longer need to lock yourself into a tempo and go
through great pains to make your Loops and samples fit that tempo. ACID Style
will take all of your audio and make it match any tempo you choose in real
time! However, there are a few key concepts that will allow you to best utilize
ACID Style:

Types of Tracks
There are three types of Tracks that you deal with in ACID Style: Loops, One-
Shots and Disk-Based.

Loops
Loops are small chunks of audio that are designed to create a contiguous beat
or pattern when played repeatedly. Loops are usually one to four measures long
and are stored completely in RAM for playback.
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Loops are the type of Events that you will use most frequently. Because a Loop
Track allows Events to be continuously “drawn” across it, the arrangement of
Loops is very easy.

One-Shots
One-Shots are RAM-based chunks of audio that are not designed to loop.
Things such as cymbal crashes and sound bites could be considered One-Shots.
Longer files can be treated as One-Shots if your computer has sufficient
memory.

The main difference between a One-Shot and a Loop are that they will not
change tempo with the rest of the Loops. One-Shots are also different in the
way they can be edited in the Track View. One-Shots will not “draw” across the
Track, instead they will be inserted in their entirety as a single block of audio.

Disk-Based
Disk-Based files are usually longer chunks of audio that get played off of hard
disk rather than being stored in RAM. Disk-Based files make sense for vocals or
any other long audio file that does not loop.

Not a Multitrack
Any given Loop, One-Shot, or Disk-Based file takes up one Track. ACID Style is
not a “multitrack,” in the sense that you can put any audio regions you want
on a single Track.ACID Style is designed so that a Track is a time line for a single
Event. This makes it easy to place and edit Events with respect to other Events
on other Tracks without worrying about whether or not you are editing the
right piece of audio.

ACIDizing Files
All of the Loops on the ACID Style CD-ROM are “ACIDized.” This means that
tempo and key information have been stored in the Loop so that ACID Style has
an easier time stretching and pitch-shifting them when they are used together
in a project.

a c i d  s t y l e  t u t o r i a l1 0



You do not need to ACIDize your Loops to use them in ACID Style. ACID Style
will make good guesses about the tempo of a file, and it will be right about 99%
of the time.You can also temporarily set the Root Note of the file so it will be
transposed to the project’s key. However, if you want to use files in multiple
projects, you will want to ACIDize them so that these properties will
automatically be set whenever you open the file.

Specific information on ACIDizing files is contained in the Setting Track and
Event Properties section of this manual.

Getting Around in the ACID Style Window
The ACID Style window is divided into three main areas: the Track View, the
Track List, and a multi-function section that houses the Explorer and
Properties pages. All of these areas can be sized to your preferences by clicking
on and dragging the divider bars between them.
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The Track View is the area of the application that contains the arrangement of
the audio Events. It is the area where most of your work will be done.

The Track List is the area to the left of the Track View that contains the master
controls for each Track. From here you can adjust the mix, select playback
devices, and reorder Tracks, among other things.

The lower half of the ACID Style window is the multi-function section that
contains the Explorer and Properties pages. These pages allow you to add new
loops and set important properties of your Tracks and Events.

The easiest way to learn about a part of the ACID Style window that you do not
know about is to use What’s This? Help. Enable What’s This? Help by pressing
Shift+F1. Next, click on anything in ACID Style. A context-sensitive Help
popup window will be displayed that will give you information about the item
that you clicked on.

Using the Toolbar
The ACID Style Toolbar, located above the Track List and Track View, is accessible
from anywhere within the ACID Style system. The buttons available on the
Toolbar will vary, depending on where you are in the system, and the actions
you are performing.The buttons are explained in the order that they appear on
the Toolbar. When you are in the ACID Style system, you can hold the cursor
over a Toolbar button to view the name of the button.

The New button allows you to begin a new ACID Style project.

The Open button allows you to open an existing ACID Style project.

The Save button allows you to save the current project.

The Cut button allows you to cut the current selection and place it on the
ACID Style clipboard.
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The Copy button allows you to copy the current selection and place it on
the ACID Style clipboard.

The Paste button allows you to take the selection on the ACID Style
clipboard and paste it to the selected location within the ACID Style project.

The Undo button allows you to undo your last action.

The Redo button allows you to redo the last action that you undid.

The Record button opens the Record window, which allows you select a
device to record from, the attributes of the recorded file, and where on your
hard drive the file will be recorded.

The Play Looped button toggles the looped playback mode between “on”
and “off.”

The Play All button allows you to play the project from the beginning of the
project, no matter where the cursor is currently positioned.

The Play button allows you to play the project beginning at the current
cursor position.

The Pause button stops playback and leaves the cursor at its current position.

The Stop button stops playback and returns the cursor to its original
position.
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The Go to Start button returns the cursor to the start of the project.

The Go to End button returns the cursor to the end of the project.

The Draw Tool button contains most of the functionality that is available in
the Track View.This button allows you to add, delete, and edit Events.This is
the tool you will likely use most frequently.

The Select Tool button allows you to quickly select multiple Events across
Tracks, using selection boxes.

The Paint Tool button allows you to paint Events across multiple Tracks.
With the Paint Tool selected, Events can be painted across multiple Tracks as
easily as clicking and dragging the mouse. The Paint Tool is different from
the Draw Tool in that it can cross Track boundaries.

The Erase Tool button allows you to “spot erase” sections of an Event.

The Zoom Tool button allows you to quickly change the magnification of
the Track View by drawing magnification boxes with the mouse.

The What’s This? button allows you to view Help specific to any item on the
ACID Style window.To use this option, click on the What’s This? button, and
then click on the item for which you want help.



Customizing the Toolbar
The ACID Style Toolbar is fully customizable. To add or remove buttons from
the Toolbar, double-click on a blank space between two buttons or at the end
of the Toolbar.The Customize Toolbar window displays.The column on the left
lists all of the available buttons that are not currently displayed on the Toolbar.
The column on the right lists all of the buttons that are displayed on the
Toolbar.

To place a button on the Toolbar, select the button you want to add from the
list on the left and press the Add button. You can also double-click on the
button to add it.The new button displays in the list on the right.You can add a
Separator from the list on the left between buttons to place them into logical
groups.

To remove a button, select it from the right column and press the Remove
button. You may also double-click on the button in the list on the right to
remove it.

You can reorder the buttons on the Toolbar by selecting the button you want
to move in the right column and pressing the Move Up or Move Down
buttons.

If you decide you would like the Toolbar to be returned to its original
configuration, press the Reset button.

You do not have to go into the Customize Toolbar dialog to reorder or delete
buttons. If you press the <Shift> key on your keyboard and click on a button
on the Toolbar, you can pick it up and move it to a different location. If you
drop the button on a part of the ACID Style window that is not the Toolbar, the
button is deleted.
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Using the Media Explorer
Using the Media Explorer is the easiest way to find and preview Loops and
other audio from within ACID Style.To access the Media Explorer, click on the
Explorer tab at the bottom of the ACID Style window.

Basic Navigation
The Media Explorer is designed to work in much the same way as Windows’
Explorer. On the left side is a tree view of all of the drives and folders that are
available to you. On the right side, you will see a listing of all of the files
contained in a selected folder that are valid ACID Style media. File types that
can be selected from the Media Explorer are Wave and ACID Style Projects.

By default, the left side of the Media Explorer will display Windows’ My
Computer and Network Neighborhood as well as any Library Folders that have
been defined.To browse through these items, click on the plus sign next to the
icons or double-click on the icon itself.

As you expand folders, you will notice the contents of the folder displayed on
the right side of the Media Explorer window. At any time, you may double-
click on a file on the right and add it to your ACID Style project.

Files may also be dragged into the Track View or Track List to be added.
Using this method, multiple files can be added at once.
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To collapse any part of the folder tree on the left side of the Media Explorer,
click on the minus sign next to the icon or double-click on the icon itself.

Creating Libraries
You can create a Library Folder to quickly access folders that you use frequently
in ACID Style. Any Library Folders you create appear at the top, left side of the
Media Explorer as file cabinets. These Library Folders behave exactly like any
other drive, so browsing through them is the same.

To create a Library Folder from a folder, right-click on the folder. Choose Add
as Library Folder from the shortcut menu. A new file cabinet icon appears at
the top of the list with the name of the folder and its path.

To remove a Library Folder, right-click on its icon. Choose Remove Library
Folder from the shortcut menu.The icon is removed from the list.

Previewing Loops
What makes the Media Explorer such a powerful tool is its ability to preview
Loops before you open them. The previewing capability saves you time by
eliminating the trial-and-error approach to choosing Loops.

The Loop previewing can be manual or automatic. To enable Auto Preview
mode, check the Auto Preview checkbox in the bottom right corner of the
Media Explorer window.Whenever you click on a file, it will begin to preview.
When this checkbox is unchecked, you must press the Play button next to
it to begin previewing the selected Loop. To stop the playback of a Loop, press
the Stop button.You can adjust the volume of the Loop using the Volume
fader to the left of the Play button.

You can also preview Loops while the current ACID Style project is playing.This
is an invaluable feature when deciding what Loops work well together.

Begin by starting the playback of the project, and then select any Loop to
preview.The selected Loop will play in sync with the rest of project. If you like
the Loop, double-click on it to add it to the project. If you do not like the Loop,
simply choose another one to preview.
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Very small files that have not been ACIDized may not preview correctly.
If ACID Style does not guess the file’s tempo correctly, it must be
ACIDized first for proper results.

Basic Editing in the Track View
The Track View is the main part of the ACID Style window where you will be
doing most of your work. Each Track should be thought of as a timeline for
each Event.

Lay of the Land
The Track View is made of several different elements, each with their own
intended function. The bulk of the window is made up of actual Track space.
This area will contain the drawn Events on each Track. However, there are other
aspects of the Track View to become aware of.

Beat ruler

Time zoom controlTime rulerHorizonal scroll bar

Vertical 
scrollbar

Zoom level
control
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Along the top of the Track View is the Beat Ruler.This timeline will allow you
to place Events in reference to the musical time of bars and beats.This timeline
is fixed and will not update when you change the tempo.This allows the Events
in the Tracks to maintain their size when the tempo is adjusted.

Along the bottom of the Track View is the Time Ruler. This timeline can show
real-time in many different formats.To change the format of the display, right-
click on the timeline and choose an option. A complete explanation of the
options is available in the “ACID Style Reference” section of the Help file under
“Time Ruler Format.”This timeline will change with tempo, since the number
of bars and beats per second of real time will change with tempo.

Below the Time Ruler is the horizontal scroll bar. Clicking on and dragging this
scroll bar will pan the view of the project left or right. The ends of this scroll
bar also function as zoom controls. By clicking on and dragging the very edges
of the scroll bar, you can zoom the project in and out to various levels of
magnification.

Double-clicking on the horizontal scroll bar will zoom the project out so
that the entire project, from beginning to end, will be displayed.

To the right of the Time Ruler are the dedicated Time Zoom controls. Clicking
on the larger of the two magnifying glass icons will increase the magnification
around the cursor position. Clicking on the smaller of the two icons will
decrease the magnification around the cursor position.

On the right side of Track View is the vertical scroll bar. Clicking on and
dragging this scroll bar will pan the view of the project up and down.

Double-clicking on the vertical scroll bar will zoom the project out so that
as many of the Tracks in the project, from top to bottom, will be displayed
as possible.
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Directly below the vertical scroll bar are the dedicated Track Height Zoom
controls. Clicking on the larger of the two magnifying glass icons will increase
the level magnification of the project.This will allow you to better see low-level
material in the Tracks at the cost of seeing fewer Tracks on the screen at one
time.To decrease the level of magnification, press the smaller of the two icons.

Adding Events to a Track
Once you have created a Track by adding a file from the Media Explorer, you
will want to tell ACID Style when to play the Event.The Draw Tool, located on
the Toolbar, will facilitate this.

The Draw Tool, pictured to the left, is the tool that you will probably use
most often. It allows you to accomplish most of the functions in the Track
View.You can add an Event by clicking on the empty Track and dragging the
Draw Tool to the right.The farther you drag the mouse to the right, the more
times the Loop will be repeated. Repetitions in the Loop are denoted by the
black indents in the top and bottom borders of the Event.

Using the Draw Tool, you can build a project by “drawing” Events in your
Tracks anywhere you like.

Playback Navigation

After you add some Events, you will undoubtedly want to hear how your
project sounds.To play the project from the beginning at any time, press the
Play All button on the Toolbar. This will start playback of the project from
the very beginning, no matter where the cursor is currently positioned.

To play from a specific point in the project, click anywhere on the Track
View, with the Draw tool selected, and press the Play button on the Toolbar.
The cursor moves to that location and begins playing.

To stop playback, press the Stop button on the Toolbar. The Stop button
differs from the Pause button in that it stops playback and returns the cursor
to its starting position. The Pause button stops playback, but leaves the
cursor at its current position.
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Other buttons are provided for playback navigation as well. The Go to Start
and Go to End buttons bring the cursor back to the start and end of the
project, respectively.

Looped Playback
Looping the playback of your ACID Style project is useful when you want to
concentrate on a certain section. The region in which playback will loop is
defined by the Loop Region.There are two ways to make playback loop within
the Loop Region:

1. Press the Play Looped button on the Toolbar.

2. Right-click on the Loop Region and choose “Play Looped” from the shortcut
menu.

To move the Loop Region as a single entity, click on and drag the inside bar
between the endpoints of the Loop Region. Moving the Loop Region in this
way will maintain the length of it. To edit the length of the Loop Region,
click on and drag either of the endpoints.

Double-clicking on the inside colored bar of the Loop Region forces the
endpoints to the extents of the Track View window. If your project does not
fill the Track View window, the Loop Region is forced to the beginning and
end of your project.

Several shortcuts exist to manipulate the location of the Loop Region:

• Press the <Ctrl> key while you click to move the start of the Loop Region
to wherever you click.

• Press the <Ctrl>+<Shift> keys while you click to move the end of the
Loop Region to wherever you click, unless you click before the current
start of the Loop Region. In this case, the start of the Loop Region moves
to the point where you clicked.



Changing Tempo and Key
A project can be played at any tempo or key.To adjust these parameters, look at
the controls to the left of the Time Ruler. The long slider is the Tempo slider.
The tuning fork icon is the Key control.

To adjust the tempo, click on and drag the Tempo slider. Dragging the slider to
the left slows the tempo, while dragging it to the right speeds the tempo.

To move the slider in finer increments, click on the small arrow buttons to the
right of the Tempo slider.These buttons will move the tempo by fractions of a
BPM.

An exact tempo value may also be entered directly by double clicking on Tempo
text.The text will turn into an edit control into which you may type a tempo.
Press the Enter key on the keyboard when you are finished.

a c i d  s t y l e  t u t o r i a l2 2

Tempo slider Key control



note

The key of a project can be adjusted using the Key control. Each Loop that has
a specified Root Note in its properties will be transposed to the key indicated
by the Key control. To change the key, click on the Key control and choose a
new key from the list. This feature makes it possible to use Loops that are in
different keys in the same project.

For example, if you have three Loops that have Root Notes of A, B and C and
your Key control is set to D, the loops will be pitch-shifted by 5, 3 and 2
semitones, respectively.

The Tempo slider and Key control can both be adjusted in real time as the
project is played back.

Editing Events
There are many things that you will want to do with an Event after you draw
it. The Draw Tool can also be used to do this basic editing to Events that you
have drawn.

Many times you will want to move an Event after creating it. To do this, click
on the Draw Tool, followed by the Event you wish to move. Drag the Event to
the new location. Multiple Events can be moved at the same time by clicking
on the first Event to select it and then holding down the Control key and
clicking on the other Events that you wish to move. With all of the Events
selected, you may now click on any one of the Events and drag them all to a
new location.

Changing the length of an Event is also a common task. This can be
accomplished by placing the mouse over the very edge of the Event.The mouse
cursor will change into a bi-directional arrow indicating that it can be dragged
in either direction. Now, click on and drag the edge as far as you want.

To delete an Event from a Track, click on the Event and press the <Delete> key
on your keyboard.
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Cutting, Copying and Pasting Events
Just like a word processor for audio, ACID Style will allow you to cut, copy, and
paste Events into new locations.

To cut, select the Event or Events you wish to remove and press the
<Ctrl>+<X> keys on your keyboard. This command removes the selected
Events and places them onto the ACID Style clipboard.You may now paste the
cut Events anywhere in the ACID Style project by placing the cursor where you
would like them to go, and pressing the <Ctrl>+<V> keys on your keyboard
to paste them.

An important thing to remember is that Events will always be pasted back in
their own Tracks. There is no way to paste a group of Events from one set of
Tracks to another.

Also, pasted Events will sit on top of other Events in the Track if they overlap.
To make space for pasted Events, rather than pasting them on top of existing
Events, press the <Ctrl>+<Shift>+<V> keys on your keyboard, or choose
Paste Insert from the Edit menu. This command pastes the Events at the
current cursor position, but moves any existing Events over to make room for
them.

If you want to copy an Event or group of Events rather than cut them, select
the Events and press the <Ctrl>+<C> keys on your keyboard. All of the
selected Events will be copied to the ACID Style clipboard and are available to
paste back into the ACID Style project.

You may also copy a group of selected Events by holding down the
<Ctrl> key, clicking on a selected Event, and dragging it to a new
location.
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Editing in the Track List
The Track List is located to the left of the Track View. This section contains
controls for each Track, including Mute, Solo, and Volume, to name a few.

Adjusting the Mix
Each Track has its own master level and pan control. All of these controls are
accessed with the Multi-purpose fader on the Track List.

To select a function for the fader to control, place your mouse over the fader
label (it should read “Vol: <some number>”) and click. A drop-down list
appears with choices for Vol (short for Volume) and Pan. Once you have
selected one of the choices, moving the fader to the right of the drop-down list
adjusts the value of that control.
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Volume will control how loud the Track is in the mix. A value of 0 dB means
that the Track will be playing at its normal volume (the volume at which it was
recorded) with no boost or cut from ACID Style. Negative numbers will cut the
volume, while positive numbers will boost the volume. Double-clicking on the
fader sets the value back to 0dB.

When adjusting the mix of your Tracks, remember to look at the meters
next to the Media Explorer. Because you are adding the volumes of all of
the Tracks together, it is easy to clip the audio output. Make sure that the
meters never have the red Clip indication lit while playing.

Pan controls where the Track is placed in the stereo field. Moving the fader to
the left places the Track in the left speaker more than the right, while moving
the fader to the right places the Track in the right speaker. Double-clicking on
the fader sets the value back to the center of the stereo field.

If multiple Tracks are selected, the faders all move together as a group.

Mutes and Solos
Often, it is necessary to listen to individual Tracks or to NOT listen to certain
Tracks while you are playing a project.These functions are handled by the Mute
and Solo buttons, found on the Track List area.

Pressing the Mute button on any Track keeps that Track from being played in
the mix. To unmute a Track, press the Mute button again. When a Track is
muted, the Track is “grayed out” in the Track View.

If you select multiple Tracks, the Mute and Solo buttons can be activated
on all of the Tracks simultaneously. To select multiple Tracks, press the
<Shift> or <Control> key on your keyboard while you click on the
Track icons.
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The inverse of the Mute button is the Solo button. Pressing the Solo button on
a Track mutes all of the other Tracks in the project. Pressing the Solo button on
the other Tracks unmutes them one at a time, allowing groups of tracks to be
soloed.To un-solo a Track, press the Solo button on the original Track again.

You can change the behavior of the Solo button so that pressing it will
only solo that Track, as opposed to adding it to the solo group.To enable
this behavior, press the <Control> key on your keyboard while you
click on a Solo button.

Reordering Tracks
Tracks can be moved around to create logical groupings at any time during a
project’s creation. To move a Track, click on its icon and drag it to a new
location. The new location is indicated by the highlighted line separating the
Tracks.

Multiple Tracks can be moved at one time by first selecting all of the Tracks, and
then following the procedure above. To select multiple Tracks, press the
<Shift> or <Ctrl> keys on your keyboard while you click on the Track icons.

Recording
ACID Style can record an audio input from a sound card while playing the
current ACID Style project. This feature allows you to create your own Loops
and Disk-Based Tracks.

Recording Basics

To open the Record window, press the Record button on the Toolbar. From
this window, you can set the attributes of the recorded file, indicate where
on your hard drive the file will be recorded, and begin recording, among
other things.

note



Before You Begin
Before you begin recording, determine whether your sound card supports
simultaneous play and record. If it does not, place a check in the Play while
recording check box. If your sound card does support simultaneous play and
record, leave this checkbox blank. If you are not sure, contact your sound card
manufacturer or check the documentation included with your sound card.

When you are ready to record, press the Start button. When you are finished
recording, press the Stop button. The recording is added as a new Track at the
end of your project.

If the recording is smaller than the Play files from disk if bigger than… threshold you
have set in the Preferences window (accessed by clicking on the Options menu,
followed by the Preferences menu option), it will be stored in RAM. Otherwise,
the Track will be Disk-Based.You may also choose whether or not the new Track
will change tempo with the project. To enable this feature, click the Make new
track follow project tempo checkbox on the Record window prior to recording.

If Play Looped is turned on in the ACID Style project (i.e., using the Play
Looped button on the Toolbar), playback will loop as you are recording. The
recording that you make will be recorded as a single Track.
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Record From…
By default, the recording and playback will commence from the current cursor
position. However, you can change the start position from the Record window
by following these steps:

1. In the Record from area on the Record window, click on the Position radio
button.

2. Type in a new project position in measures and beats format.

At any time, you can select the Start of project radio button to begin recording at
the beginning of the current ACID Style project.

Recording Attributes
There are three attributes that make up a recorded digital signal: Sample size,
number of channels, and Sample rate.

Sample size controls the resolution of the recorded signal. CD quality audio is
recorded at 16-bits per sample and most sound cards can record at this
resolution.The only sample size available in ACID Style is 16-bit.

The sample rate attribute determines the sample rate at which you will record
and play.The only sample rate available in ACID Style is 44,100 Hz.

Channels, controlled in the Record window, simply control whether the
recorded signal will be mono (one channel) or stereo (two channels). If you
are recording mono, you will need to use the left channel of your sound card
for input.
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Monitoring Levels
ACID Style provides a responsive meter on the left side of the Record window
to monitor the incoming signal level of the chosen recording device. It is
important that you record with as high a signal as possible without clipping.

“Clipping” occurs when the incoming signal is too high to represent as a digital
value. The result is a nasty distortion in the recording. A clip will be indicated
with a red Clip warning at the top of the meters.

The peak signal level will be displayed at the top of the meters in decibels.
Remember that a reading of 0 dB is as high as you can possibly go with a digital
signal.

To clear this reading at any time, click on the numbers.The numbers reset and
a new peak reading will be calculated.

Monitoring Audio
It is important to note that the Monitor checkbox in the bottom left corner of
the Record window is only for level monitoring. Monitoring or listening to the
incoming audio is a completely different story, and can be a point of confusion.

The fail-safe way to monitor your incoming audio while you record is to listen
to the source before it goes into the sound card.

For example, let’s say that you are recording a guitar, and you have the
microphone plugged into a mixer, which is then hooked up to your sound
card.You will want to listen to the incoming guitar signal through the monitor
outputs of the mixer, rather than the outputs of the sound card. In this way, you
will always hear the recorded signal, regardless of the capabilities of your sound
card. The timing of the recording, with respect to the existing Tracks, will be
more accurate.

The downside to this method is that you will not be hearing the audio in a
post-sound card method prior to the recording actually being made.Therefore,
the quality of the sound you hear and the quality of the sound that is really
recorded will be slightly different, depending on the hardware you are using.
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Some sound cards will automatically route the incoming audio signal to the
outputs of the card during recording.This is a better way to monitor the audio,
since you will hear it after the analog-to-digital conversion. However, most
cards that support this feature do not support it while playing back audio at the
same time. This method makes simultaneous recording and playback
impossible.

For more detailed information, check the documentation of your audio
hardware to verify its capabilities prior to recording with ACID Style.

Setting Track and Event Properties
The Properties page, available in the multi-function area at the bottom of the
ACID Style window contains options to modify the behavior of whole Tracks
or Events on a Track. From this page, you can “ACIDize” files, or edit the start
point and pitch of a specific Event.

To view and/or modify the properties of a Track or Event, follow these steps:

1. Select the Track.

2. Click on the Properties tab in the multi-function area at the bottom of the
ACID Style window.

3. Click on the Track tab.

4. Make any necessary changes, if applicable, and click on the Save As button.

ACIDizing a File
“ACIDizing” a file involves adding an extra chunk of information to the audio
file that is ACID Style-specific. This information contains all of the properties
on the Track tab in the Properties window including the root note and number
of beats or tempo of the file. This information is then used by ACID Style to
pitch-shift the file for you automatically when you open it.

All of the audio contained on the ACID Style CD-ROM is ACIDized. Non-
ACIDized files will open correctly; however, they will not conform to the key
of the current project.
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To ACIDize a file, click on the Track tab of the Properties page and press the Save
As button. This button will open the Save As dialog and allow you to save the
ACIDized file as a new file or a replacement of the current file.

If you cannot or do not wish to save a new file, you can set the properties and
they will be saved with the ACID Style project. However, this means that you
will have to set the properties for every project that you use a given loop in.
ACIDizing the file allows you to “set and forget” the properties so that they will
be the same in any project you choose.

If you edit an ACIDized file in another audio editing program, it is
possible that the ACID Style specific chunk of data will be removed.The
file will have to be re-ACIDized in ACID Style.

Modifying Track Properties
The Track properties are the properties that determine how a file behaves in
ACID Style. These are also the properties that get saved into the file when you
ACIDize it.

There are three types of Tracks that ACID Style deals with: Loops, One-Shots
and Disk-Based. These types are described in detail in the Explaining the
Paradigm section of this Help file. You can change how ACID Style uses the
current Track by changing the Track type control.

When Loop is selected, the length of the original file, in beats, is required for
ACID Style to stretch it properly. Setting a value in the Number of beats control
that does not match the actual file will cause the loop to play at a different
speed than normal. For example, specifying 8 beats for a Loop that is actually
4 beats, will cause the loop to play twice as slow at any given tempo.

When Disk-Based is selected, the tempo of the original file is required for ACID
Style to stretch it. If you do not want ACID Style to stretch the file at all,
uncheck the Stretch from tempo option. Like a Loop, if you specify a tempo that
is not the actual tempo of the file, the Track will play at a different rate.
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The Root note for transposing control sets the base note for Loops and Disk-
Based Tracks that you wish to conform to the project key. If you do not wish a
Track to transpose to the song key (i.e. a Track that contains a drum sample)
choose Don’t transpose.

Modifying Event Properties
Individual Events on Tracks also have their own set of properties.To access these
properties follow these steps:

1. Select an Event.

2. Click on the Properties tab at the bottom right corner of the ACID Style
window.

3. Click on the Event tab.

The Event properties include Start offset, Pitch shift, and a Quick fade edges to
prevent clicks. These properties are not saved into the files when a Track is
ACIDized.They are only saved with the project.

The Start offset property for an Event specifies a playback starting position that
is different than the beginning of the file. This offset is handy for adding extra
variation to your Tracks by starting them at different places. This is especially
useful for Loops; you can change the feel by simply starting the Loop at beat 2
rather than beat 1.

There are three different ways to edit the Start offset property:

1. The most precise way is to type in the number of samples you wish to offset
by in the Start offset field. For obvious reasons, this will probably not be your
preferred way of editing the offset.

2. Move the Start Offset Marker in the waveform display on the right side of
the Event Properties window.

3. From the Track View area, hold down the <Ctrl> and <Shift> keys on your
keyboard and click on the Event that you wish to offset. Next, drag the
mouse left or right to change the offset. Notice the waveform scrolling
within the Event boundaries.
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When you add an offset to an Event, or even edit an Event such that it does not
end on a loop point, it is quite possible to introduce a click in the playback at
the edges of the Event.This click can be easily eliminated by checking the Quick
fade edges to prevent clicks checkbox on the Event tab.With this property selected,
ACID Style performs a very quick fade in or out on the Event edges so that any
nasty clicks are smoothed out of existence.

The Pitch shift property allows you to shift the pitch of the selected Event or
Track by the specified number of semitones. The pitch shift of an Event is
calculated after the project key and the Track’s pitch shift.

Advanced Track Editing
Once you have become familiar with the basics of creating and editing your
ACID Style projects, you will want to start experimenting with some of the
more advanced procedures. In this section, we explain some of these advanced
features.

While most of the functions that you will use can be initiated using the Draw
Tool, there are five other tools on the Toolbar that make specific tasks easier.
The other tools include the Select Tool, Paint Tool, Erase Tool, Zoom Tool, and
Envelope Tool.These tools are explained below.

The Select Tool
The Select Tool is designed to quickly select multiple Events across Tracks using
selection boxes.There are three types of selection boxes that can be drawn using
the Select Tool: vertical, horizontal, and free selection.

To change the type of selection box you are using, first click on the Select Tool.
Next, hold the left mouse button down and click the right mouse button at the
same time. Clicking the right mouse button will toggle between the three types
of selection boxes.These selection boxes are explained below.
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The free selection box is the default behavior of the Select Tool. It allows you
to draw a selection that begins where you start drawing and ends where you let
up on the mouse.This selection box will select all of the Events that are touched
by the extents of the box. This method is good for selecting a group of Events
that are close together.

The vertical selection box can be used to easily select Events across all Tracks
that occur within a specified time range. The vertical selection box
automatically selects all of the Tracks between your first mouse click and where
you draw the selection box; Tracks that are not visible at the current
magnification are also selected.

The horizontal selection box can be used to easily select all Events on a single
or multiple adjacent Tracks. The horizontal selection box automatically selects
all of the Events on a Track that is touched by the extents of the selection box;
Events that are not visible at the current magnification are also selected.

The Paint Tool
The Paint Tool is designed to paint Events across multiple Tracks.With the Paint
Tool selected, Events can be painted across multiple Tracks as easily as clicking
and dragging the mouse.The Paint Tool is different from the Draw Tool in that
it can cross Track boundaries, so this tool excels at adding a random element to
your ACID Style projects.

Painting across two or more existing Events on a Track merges them into one
contiguous block. This is useful if you need to repair a gap that you created
using the Erase Tool.

Right-clicking with the Paint Tool causes the tool to function like the
Erase Tool.
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The Erase Tool
The Erase Tool allows you to “spot erase” sections of an Event. With the Erase
Tool selected, click once in the middle of an Event.The Event splits at the closest
Snap point to the spot where you clicked. If you click and drag with the Erase
Tool across an Event, the Event is erased in chunks equal to the current Snap
value.

Right-clicking with the Erase Tool causes the tool to function like the
Paint Tool.

The Zoom Tool
The Zoom Tool is designed for changing the magnification of the ACID Style
project. Like the Select Tool, there are three types of zoom boxes that the Zoom
Tool can use: time, height, and free zoom.

To change the type of zoom box you are using, first click the Zoom Tool on the
Toolbar. Next, hold the left mouse button down, and click the right mouse
button. Clicking the right mouse button toggles between the three types of
zoom boxes.These types of zoom boxes are explained below:

The free zoom box is the default behavior of the Zoom tool. It allows you to
zoom into a section of your ACID Style project in both time and level at the
same time.

The time zoom box is used to zoom into a specific chunk of time in the ACID
Style project, while maintaining the current track height zoom. Click and drag
anywhere across the ACID Style project to zoom into that specific area of time.

The track height zoom box is used to maximize the size of a Track or group of
Tracks in the ACID Style window. This allows edits to be made with reference
to the low-level audio in the Event, thereby resulting in greater precision. Click
and drag anywhere from top to bottom in the ACID Style project to zoom in to
the Tracks encompassed within the zoom area.

Double-clicking anywhere on the project with the Zoom Tool zooms out
so that the entire project fits in the Track View.
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Using Markers
Markers are a handy way to ease navigation in the Track View. To create a
Marker, place the cursor in the project where you want to add it and press the
“M” key on the keyboard. A Marker will be added at the cursor position, in the
form of a red line with a numbered tab at the top.

Markers can be used to indicate sections of projects such as chorus, verse, etc.
They can also be used for on-the-fly type uses such as marking a part in the
project that you want to come back to edit later on.To move a Marker, simply
click on its tab above the Beat Ruler and drag it to a new location. You can
create up to ten markers. Each Marker (up to 10) is assigned a number. Pressing
this number on the keyboard move the cursor to the corresponding Marker.
This can even be done while playing the project.

You can display more options for the Marker by right-clicking on the Marker
tab, which displays a shortcut menu. Using the Go To option from the menu,
you can move quickly to another Marker.You can use the Rename option on
the shortcut menu to name and rename Markers. The Delete option on the
shortcut menu allows you to delete the selected Marker.

Tempo and Key Maps
ACID Style allows you to add automatic tempo and key changes within a
project using Tempo and Key Change markers.These markers are added on the
Time Ruler at the bottom of the Track View. When the cursor passes over one
of these markers, the master project tempo and/or key will change in real time.

To add a Tempo and/or Key Change marker, right click on the empty bar
directly between the Time Ruler and the horizontal scroll bar and choose the
type of change you want to add from the shortcut menu.You can add a Tempo
Change, Key Change, or both.

There are two ways to edit the tempo and/or key of the marker:

1. Place the cursor on or after the marker and adjust the Tempo slider and Key
control below the Track List. Whatever these controls are set to will be
reflected in the text of the marker.

2. Double-click on the text of the marker and type the exact value you want.
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When editing a combination Tempo and Key Change marker, you do not
have to type both values if you only want to edit one of them. For
example, if the current marker value is 130,A and you only want to edit
the key, you can simply type in B and press <Enter>.The marker will
now be 130,B.Tempo works the same way.

Changing Snaps
“Snapping” is a way to make sure that all of your Events and Markers in the
Track View line up perfectly with each other. ACID Style allows you to change
the resolution of the snapping to accommodate your working style.

To change the snap resolution, select the Options menu, followed by the Snap
To option. Select the resolution you want to use. To disable snapping
completely, uncheck the Enable Snap To menu option from the Options
menu.

You can temporarily disable snapping while editing an Event by holding
down the <Shift> key.



ACID Style Reference

This section is devoted to explaining the function of every menu item and
window in ACID Style. Options on each window are also explained. For menu
options, information on shortcut keys is displayed next to the menu or menu
option name in parenthesis. Shortcut keys are keys you can type on your
keyboard to quickly access a menu option function. In addition, you can look
here to answer questions like, “I wonder what this button does?”

File Menu (<Alt> + <F>)
The options on the File menu are explained below:

New (<Ctrl> + <N>)
Selecting this command opens a blank ACID Style project. If you currently have
an ACID Style project open that has not been saved, you will be prompted to
save your changes first.

Open (<Ctrl> + <O>)
Selecting this command displays the Open File window. From this window you
can browse all of the available drives to select an ACID Style project or audio
file to open.

If you choose an ACID Style project and there is an unsaved project currently
open, you will be prompted to save your changes first. If you choose an audio
file, the file will be opened as a new Track in the current ACID Style project.
The fields and buttons on this window are explained below:
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Look in
This field specifies the current folder. All of the files available in the folder
appear in the space below this field.

File name
This field specifies the file you wish to open.You may type a name in or click
on a file in the list above this field.

Files of type
This field specifies the type of file you wish to open.The type of files you select
in this field limits which files are displayed in the list above.The types available
are:

ACID Style Projects and Audio Files (*.acd, *.wav)

An ACID Style project file (*.acd) contains all of the information about a single
project. All of the Track layout and other settings are saved in this project file.
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Wave files (*.wav) are the standard audio file format for digital audio on
Windows computers.ACID Style will allow you to open any 16 or 24-bit PCM,
non-compressed Wave files.

Recent
The Recent list is a quick way to navigate the Open dialog. Folders that you
frequently use will be available to choose from this list. When you select a
folder from this list, all of the files in that folder appear in the space above.

Close
This command closes the current project.

Save (<Ctrl> + <S>)
This command saves the changes to the current project.

Save As
This command displays the Save As window. From the Save As window, you can
save the current project to a new location, to a new name, or render the project
as a Wave or ASF file. The fields and buttons on this window are explained
below:

Save in
This field specifies the folder you wish to save to. All of the files available in the
folder will appear in the space below.

File name
This field specifies the file you wish to save. You may type a name in or click
on a file in the space above.

Save as type
This field specifies the type of file you wish to save to (e.g., *.ACD or *.WAV
files).These file types are explained below:
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ACID Style Project (*.acd)

An ACID Style project file contains all of the information about a single project.
All of the layout of Tracks, settings, etc., are saved in this project file. This type
of file does not contain any audio, only references to audio files.

ACID Style Project with external audio (*.acd)

By saving a project file in this manner, all of the audio that is being used in the
project will be copied into the same folder as the project file.This makes it easy
to move a project around without having to reestablish the audio file references
every time.

When this option is selected, a new option called Include Disk-Based audio
files appears. When this option is not selected, the Disk-Based Tracks will not
be copied to with the new project. However, the link to the file will still be
contained in the project.

ACID Style Project with embedded audio (*.acd)

By saving a project file in this manner, all of the audio that is being used in the
project will be embedded into the project file.This option is ideal for archiving
a finished project as there is only one file to keep track of.

When this option is selected, a new option called Include Disk-Based audio
files appears. When this option is not selected, the Disk-Based Tracks will not
be copied to with the new project. However, the link to the file will still be
contained in the project.

Mixed Wave File (*.wav)

The entire project can be rendered into a single Wave file by choosing this
option. When this option is selected, a new drop-down list called Attributes is
displayed. From the Attributes list, you can choose the desired sample rate, bit
depth, and number of channels for the output file.

Mixed NetShow Active Streaming Format (*.asf)

The entire project can be rendered into a Microsoft Active Streaming Format
file for broadcast over the Internet. A new drop down list called Preset and an
Advanced button are displayed when this option is chosen.

The Preset list contains a set of commonly used formats for creating Internet
ready audio. If you do not wish to use a preset from the list, press the Advanced
button.
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Pressing the Advanced button opens the Active Streaming Format Settings
dialog. From this dialog you can choose custom settings for the ASF file output.

Preset

This list contains commonly-used settings for creating ASF audio files. This
option only displays when you have selected the .ASF format in the Save As Type
field.

Format 

This list contains all of the available audio codecs installed on your computer.
You may select any of the codecs to use when creating the ASF file.

Attributes 

This list contains all of the available attributes for the selected audio codec.The
capabilities of the selected audio codec will determine the available attributes.

Maximum lead time 

This control defines the lead time, if any, that the Microsoft NetShow player
should buffer before starting playback of the ASF file. The default is 1,000
milliseconds.The lead time can affect the bit-rate that is calculated for the ASF
file.

Enable error correction 

This control enables error correction for low bandwidth files (not greater than
150 KB per second).The error correction information is used by the Microsoft
NetShow Player to recover from bad transfers that are common on low
bandwidth connections (especially modems using standard phone lines). For
high bandwidth content (greater than 150 KB per second), error correction is
automatically disabled since the reliability of the connections required for
these files is substantially better.

Enable Wavespan

This option is used to enable a tradeoff between more efficient handling of
larger audio objects and better interleaving of client processing time with
smaller audio objects. For most audio codecs, this option should remain
unchecked. However, some newer codecs may require this option to be checked
for proper playback.
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Title

This field contains the title that is displayed by the NetShow Player when
playing the saved ASF file.

Author

This field contains the author that is displayed by the NetShow Player when
playing the saved ASF file.

Copyright

This field contains the copyright that is displayed by the NetShow Player when
playing the saved ASF file.

Rating

This field contains the rating of the ASF file. Ratings are used to by the NetShow
Player to restrict playback of certain content.

Description

This field contains a description of the ASF file.

Preset

This drop-down list contains all of the available attributes that the file(s) can
be saved in. This list is only available when you select the Mixed Wave File
(*.wav) option in the Save as type field.

Save only the audio within the current Loop Region

This option is only available when you select the Mixed Wave File (*.wav)
option in the Save as type field. When this option is checked, only the portion
of the project that is contained within the Loop Region will be saved out to a
new file.The Loop Region does not need to be active for this option to work.

Include Disk-Based Audio Files

This option is only available when you select either the ACID Project with
external audio (*.acd) option, or the ACID Project with embedded audio
(*.acd) option in the Save as type field.When this option is checked, Disk-Based
audio files are copied into the new location of the project, or embedded into
the project. Uncheck this option if you want to conserve hard-disk space, and
do not want to make copies of your large, disk-based files.
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Properties (<Alt> + <Enter>)
From the Properties window, you can store information about the current
project.The fields and buttons on this window are explained below:

Title
This field stores the title of the project.

Artist
This field stores the name of the artist that performed in the project.

Engineer
This field stores the name of the person that engineered the project.

Copyright
This field stores copyright information for the project.

Comments
This field stores comments about the project.

Exit (<Alt> + <F4>)
This command closes the ACID Style application.You will be prompted to save
any changes to the current project before closing.

Recently Used File List
A list of recently used project files will be maintained at the bottom of the File
menu. Picking a project from this list allows you to quickly return to work on
that project.You will be able to view up to six (6) recently-used files.
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Edit Menu (<Alt> + <E>)
The options on the Edit menu are explained below:

Undo (<Ctrl> + <Z>)
Use this command to undo the last edit operation. For instance, if you deleted
a Track by accident, simply choose the Undo option from the Edit menu to
replace the Track in its original position.

Redo (<Ctrl> + <Shift> + <Z>)
Use this command to re-perform an undone Event. For instance, if you decide
that you really did want to delete that Track, select Redo, and the undo will be
undone.

Cut (<Ctrl> + <X>)
Selecting this command will remove any selected Events in the Track View, and
place them onto the ACID Style clipboard.

Copy (<Ctrl> + <C>)
Selecting this command will create a copy of any selected Events in the Track
View and place them onto the ACID Style clipboard.

Paste (<Ctrl> + <V>)
Use this command to place the contents of the ACID Style clipboard at the
current cursor position. The clipboard contents will be placed on top of any
Events that occupy the same space.To have the existing Events in a Track move
in time to accommodate the pasted Events, use the Paste Insert option instead
(explained below).

a c i d  s t y l e  r e f e r e n c e4 6



Paste Insert (<Ctrl> + <Shift> + <V>)
Use this command to place the contents of the ACID Style clipboard at the
current cursor position. Any Events that occupy the same space will be moved
later in time to accommodate the pasted Events. If the cursor is in the middle
of an Event, the Event will be split at the cursor position where the new Event
is pasted.

This feature is useful when rearranging a project by moving verses and
choruses around, for example.

Delete (Clear) (<Delete>)
This command removes any selected Events from the Track View.

Select All Events (<Ctrl> + <A>)
This command selects all of the Events in all Tracks in the Track View.

Insert Silence
This command inserts a user-specified amount of blank space into the ACID
Style project at the cursor position. This feature can be used to create space in
the project for new Events.

Fit to Time
This command allows you to specify an exact length for the ACID project.ACID
will adjust the tempo accordingly to conform to the new length. The length
will be constrained to the project’s minimum and maximum tempo settings as
set in Preferences.

Tool
This sub-menu contains options to select the different tools that are available
in ACID Style.These options are explained below:
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Draw 
The Draw Tool contains most of the functionality that is available in the Track
View. Adding, deleting and editing of Events is permitted. This is the tool you
will use most frequently.You can also access the Draw Tool from the ACID Style
Toolbar.

Select
With the Select Tool, Events can be group-selected and moved by dragging
selection boxes around the Events.There are three types of selection boxes that
can be used. To select a different type of selection box, hold down the left
mouse button and click the right mouse button.You can also access the Select
Tool from the ACID Style Toolbar.

Paint 
With the Paint Tool, only adding and erasing Events is permitted.The Paint Tool
is mostly useful for creating random elements in a project, as it can add Events
by dragging across multiple Tracks.You can also access the Paint Tool from the
ACID Style Toolbar.

Erase 
With the Erase Tool, only erasing and adding Events is permitted.The Erase Tool
is mostly used for spot-erasing certain sections out of the middle of an Event.
You can also access the Erase Tool from the ACID Style Toolbar.

Zoom
With the Zoom Tool, you can quickly change the magnification of the Track
View by drawing magnification boxes with the mouse.There are three types of
magnification boxes that can be used.To select a different type of magnification
box, hold down the left mouse button and click the right mouse button. You
can also access the Zoom Tool from the ACID Style Toolbar.
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Undo All
Selecting this command reverts the project back to its last saved form, assuming
that Undos have been created for each action that has taken place.

Special
The Special sub-menu contains options for adding different types of Markers
to the Track View.The options on this sub-menu are explained below:

Drop Marker
This command places a Marker at the current cursor position. You can use
Markers for navigation purposes.

Add Tempo Change
This command places a Tempo Change Marker at the current cursor position.
You can use Tempo Change Markers to create automated, real-time tempo
changes in the project.

Add Key Change
This command places a Key Change Marker at the current cursor position.You
can use Key Change Markers to create automated, real-time key changes in the
project.

Add Tempo and Key Change
This command places a Tempo and Key Change Marker at the current cursor
position. You can use Tempo and Key Change Markers to create simultaneous,
automated, real-time tempo and key changes in the project.
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View Menu (<Alt> + <V>)
The options on the View menu are explained below:

Toolbar
This option toggles the display of the Toolbar on and off.

Zoom Normal (<F9>)
This command restores the project’s magnification to the default settings. This
feature is useful for quickly zooming to a reasonable level whether you are
zoomed in or out to the magnification extents.

Zoom Edit (<Shift> + <F9>)
This command quickly restores the Track height zoom to a level where all Track
List edit controls can be accessed. This feature is useful when you want to edit
something in the Track List, but do not want to change your time zoom
magnification.

Zoom Overview (<Ctrl> + <F9>)
This command quickly reduces the magnification of the Track View so that the
entire length of the project and as many Tracks as possible are displayed.

Display Event Pitch
This option toggles the display of pitch in each Event. When pitch-shifting
specific Events, this feature is useful for keeping track of that information.

Focus to Track View (<Ctrl> + <T>)
This command sets the input focus to the Track View. All keyboard commands
will affect (or not affect, as the case may be) the controls of the Track View.
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Explorer (<Alt> + <1>)
This command displays the Media Explorer at the bottom of the ACID Style
window.This command has the same function as choosing the Explorer tab.

Properties (<Alt> + <2>)
This command displays the Properties window at the bottom of the ACID Style
window.This command has the same function as choosing the Properties tab.

Explore Current Folder (<Ctrl> + <E>)
This command opens a Windows Explorer window of the currently selected
folder, or the parent folder of the currently selected file in the Media Explorer.
This is a useful feature for quickly renaming or deleting files, since ACID Style’s
Media Explorer cannot perform these actions.

Refresh Explorer (<F5>)
This command updates the Media Explorer window to include any changes in
the drive or folder structure.

Options Menu (<Alt> + <O>)
The options on the Options menu are explained below:

Scroll Playback
When this option is selected,ACID Style will scroll the Track View display if the
play cursor ever reaches the edge of the screen.

Enable Snap To (<F8>)
This option toggles snapping off and on. All editing functions snap to the Snap
To setting when this option is enabled.
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Snap To
These options change the resolution of the snapping. All editing functions snap
to this setting when the Enable Snap To option is turned on.

Ruler Marks
This option sets the snapping to marks of the Time Ruler.The resolution of the
marks depends on the current magnification of the Track View.

Whole Note
This option sets the snapping to whole measures.

Half Note
This option sets the snapping to half notes. In 4/4 time, a half note is two beats.

Quarter Note
This option sets the snapping to quarter notes. In 4/4 time, a quarter note is
one beat.

Eighth Note
This option sets the snapping to eighth notes. In 4/4 time, an eighth note is one
half of a beat.

Sixteenth Note
This option sets the snapping to sixteenth notes. In 4/4 time, a sixteenth note
is one quarter of a beat.

Thirty-Second Note
This option sets the snapping to thirty-second notes. In 4/4 time, a thirty-
second note is one eighth of a beat.

Sixty-Fourth Note
This option sets the snapping to sixty-fourth notes. In 4/4 time, a sixty-fourth
note is one sixteenth of a beat.
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Time Ruler Format
This sub-menu contains options for how to display time on the Time Ruler.

Samples
This option displays the Time Ruler in samples.

Time
This option displays the Time Ruler in the following format: hours:minutes:
seconds.milliseconds.

Seconds
This option displays the Time Ruler in seconds.

Customize Toolbar
This command opens the Customize Toolbar window.The fields and buttons on
this window are explained below:

Available buttons
This list contains all of the buttons that are not currently on the Toolbar.

Toolbar buttons
This list contains all of the buttons that are currently on the Toolbar in the
order in which they appear.

Add
This button moves the selected button from the Available buttons list to the
Toolbar buttons list.

Remove
This button moves the selected button from the Toolbar buttons list to the
Available buttons list.
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Close
This button closes the Customize Toolbar window.

Reset
Pressing this button sets the Toolbar back to its default setup.

Help
This button displays help for the Customize Toolbar window.

Move Up
Pressing this button moves the selected button up in the Toolbar buttons list.

Move Down
Pressing this button moves the selected button down in the Toolbar buttons list.

Preferences
The Preferences window contains various user options for ACID Style. Each
option on the Preferences window is explained below:

Automatically open last project on startup
When this option is checked, ACID Style will reopen the project that was open
the last time ACID Style was closed.

Show logo splash screen on startup
When this option is checked, the ACID Style logo splash screen will be
displayed when ACID Style starts.

Playback buffering
This slider determines the amount of playback buffering ACID uses. If you are
experiencing gaps during audio, try increasing this value.
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Play files from disk if bigger than
This option specifies the size threshold above which opened audio files will not
be stored in RAM. If you have a small amount of RAM, this number should be
lower than if you have large amounts of RAM. Files greater than this threshold
are opened as Disk-Based Tracks.

Location of preferred audio editor
This option specifies where your preferred audio editor is installed. ACID Style
automatically starts the audio editor you choose here when you select the Edit
in Audio Editor button on the Properties page Track tab.

Temporary storage folder
This option specifies the folder into which all temporary files are created.

Free space in selected folder
This field specifies the amount of free space available in the selected Temporary
storage folder.

Default All
Pressing this button restores the entire General page to the default settings.

Help Menu (<Alt> + <H>)

Contents and Index (<F1>)
This command displays the ACID Style Help file.

What’s This? (<Shift> + <F1>)
This command enables What’s This? help. When What’s This? help is enabled, a
question mark appears next to your cursor, and you can click on any portion
of the ACID Style window for help specific to the item you clicked on.
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Keyboard Shortcuts
This command displays the Keyboard Shortcuts section of the Help file. Here
you will find numerous shortcuts to speed up your work in ACID Style.

Sonic Foundry on the Web
This sub-menu contains links to various pages on Sonic Foundry’s World Wide
Web site.These sub-menu options are explained below:

Product News
This link opens the News page. Here, you will find news about new and existing
products.

Frequently Asked Questions
This link opens the ACID Style Frequently Asked Questions (FAQ) page. Here,
you will find answers to most common questions regarding ACID Style.

Online Support
This link opens the Online Support page.This page is devoted to bringing you
useful information for troubleshooting any problems you might be
experiencing with ACID Style.

ACID Style Home Page
This link opens the ACID Style home page. Here, you will find specific news
about ACID Style, as well as specifications, and other good stuff.

Send Feedback
This command sends an email message to feedback@sonicfoundry.com. If you
have comments about ACID Style or any of our products, we want to hear from
you.

Sonic Foundry Home Page
This link opens the Sonic Foundry home page. All the latest news about Sonic
Foundry can be found here.
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About Sonic Foundry ACID Style
This command opens the About Sonic Foundry ACID Style window. On this
window, you will find copyright and registration information, as well as the
exact version number of your copy of ACID Style.

Shortcut Menus
ACID Style is filled with context-sensitive shortcut menus that can reached by
right-clicking almost anywhere in the ACID Style window.

Track List Shortcut Menu
The Track List shortcut menu is displayed by right-clicking on the icon of any
Track.The options on this shortcut menu are explained below:

Rename
This command puts the name of the Track into an editable mode. Renaming a
Track does not rename the file associated with that Track. This allows you to
give Tracks user-friendly names if the file name itself is not.

Use Loop Tempo
This command sets the project tempo to the original tempo of the selected
Loop.

Edit in Audio Editor
This command launches the Preferred Audio Editor as specified in Preferences,
and opens the selected Track. When you are done editing the file, save it and
ACID Style prompts you to reopen the Track. In this way, changes to the file can
be updated seamlessly.

Delete
This command removes the selected Track from the project.

a c i d  s t y l e  r e f e r e n c e 5 7



Duplicate Track
This command makes an exact copy of the Track and places it underneath the
selected Track. All Events are copied as well.

Pitch Shift
This command shifts the current pitch of the Track by the specified number of
semitones.This pitch shift is in addition to any pitch shifting that is happening
as a result of the project key. Pitch shifting a Track affects all of the Events on
that Track.

Color
This option specifies the color of the Track. Tracks can be color coded to
indicate logical groupings. For example, all of the drum parts can be yellow and
Synth parts can be green.

Properties
This command displays the Track’s Properties page at the bottom of the ACID
Style window.

Event Shortcut Menu
The Event shortcut menu is displayed by right-clicking on any Event in the
Track View.The options on this shortcut menu are explained below:

Cut
This command clears the Event and places it onto the ACID Style clipboard so
that it can be elsewhere in the ACID Style project.

Copy
This command makes a copy of the Event and places it onto the ACID Style
clipboard so that it can be pasted elsewhere in the ACID Style project.

Paste
This command pastes the contents of the ACID Style clipboard into the selected
Event at the cursor position.
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Delete
This command clears the Event from the Track.

Pitch Shift
This sub-menu contains commands for shifting the pitch of the selected Event.
The Event-specific pitch shift is calculated after the project key and the Track’s
pitch shift.The sub-menu options are explained below:

Up

This command shifts the pitch of the Event up one semitone.

Down

This command shifts the pitch of the Event down one semitone.

Reset

This command removes any pitch-shifting that currently exists in the Event.

Join Events (<J>)
This command combines all selected Events into one.

Split at Cursor (<S>)
This command splits the selected Event at the current cursor position.

Properties
This command displays the Event’s Properties page at the bottom of the ACID
Style window.

Track Space Shortcut Menu
The Track Space shortcut menu is displayed by right-clicking on a part of a
Track that is not occupied by an Event. The options on this shortcut menu are
explained below:

Select All on Track
This command selects all of the Events on the Track.
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Enable Snap To
This command enables snapping.

Snap To
This option selects the snap resolution.

Save
This command saves the current project.

Save As
This command displays the Save As dialog.

Zoom Normal
This command sets the magnification of the Track View to its default settings.

Zoom Edit
This command sets the track height magnification to its default settings.

Zoom Overview
This command sets the magnification of the Track View so that as much of the
project as possible is displayed.

Non-Track Space Shortcut Menu
The Non-Track Space shortcut menu is reached by right-clicking in the empty
space of the Track View that does not contain any Tracks. The options on this
shortcut menu are explained below:

New
This command opens a new, blank ACID Style project.

Open
This command displays the Open window. This window is explained in more
detail in the “File Menu” section of this manual.
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Record
This command displays the Record window.This window is explained in more
detail in the “Recording Basics” section of this manual.

Preferences
This command displays the Preferences window. This window is explained in
more detail in the “Options Menu” section of this manual.

Loop Region Shortcut Menu
The Loop Region shortcut menu is displayed by right-clicking on the Loop
Region.The options on this shortcut menu are explained below:

Play Looped
This option toggles the looped playback mode on and off.

Set Loop to View
This option sets the Loop Region to the visible edges of the Track View. If the
entire project is displayed the Loop Region is set to the ends of the project.

Set Loop to Whole Project
This option sets the Loop Region to the ends of the project.

Loop Region Space Shortcut Menu
The Loop Region Space shortcut menu is reached by right-clicking on the
empty area above the Beat Ruler, but not on the Loop Region itself.The options
on this shortcut menu are explained below:

Drop Marker (<M>)
This command adds a new Marker at the cursor position.

Play Looped (<L>)
This option toggles the looped playback mode on and off.
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Set Loop to View
This option sets the Loop Region to the visible edges of the Track View. If the
entire project is displayed the Loop Region is set to the ends of the project.

Set Loop to Whole Project
This option sets the Loop Region to the ends of the project.

Enable Snap To
This command enables snapping.

Snap To
This option displays a list of possible snap resolutions.

Time Ruler Shortcut Menu
The Time Ruler shortcut menu is reached by right-clicking on the Time Ruler.
For information on the specific formats available, please refer to “Time Ruler
Format” under the “Options Menu” section of this manual.

Tempo and Key Change Shortcut Menu
The Tempo and Key Change shortcut menu is displayed by right-clicking on a
Tempo or Key Change Marker.The options on this menu are explained below:

Tempo Change
This option toggles the tempo change property of the Tempo and Key Change
Marker on and off.

Key Change
This option toggles the key change property of the Tempo and Key Change
Marker on and off.

Go To
This command moves the cursor to the Tempo and Key Change Marker
position.
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Edit
This command puts the Tempo and Key Change Marker into an editable mode.

Delete
This command clears the Tempo and Key Change Marker.

Tempo and Key Change Space Shortcut Menu
The Tempo and Key Change Space shortcut menu is displayed by right-clicking
in the empty space below the Time Ruler, but not on a Tempo or Key Change
Marker.The options on this shortcut menu are explained below:

Add Tempo Change (<T>)
This command adds a Tempo Change Marker at the mouse position.

Add Key Change (<K>)
This command adds a Key Change Marker at the mouse position.

Add Tempo and Key Change (<Shift> + <T>)
This command adds a Tempo and Key Change Marker at the mouse position.

Go To
This command moves the cursor to the Tempo and Key Change Marker
position.

Edit
This command puts the Tempo and Key Change Marker into an editable mode.

Delete
This command clears the Tempo and Key Change Marker.
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Marker Shortcut Menu
The Marker shortcut menu is displayed by right-clicking on a Marker. The
options on this shortcut menu are explained below:

Go To
This command moves the cursor to the Marker position.

Rename
This command puts the Marker into an editable mode.

Delete
This command clears the Marker.

Folder Shortcut Menu
The Folder shortcut menu is displayed by right-clicking on a folder in the
Media Explorer.The options on this shortcut menu are explained below:

Add as Library Folder
This command creates a Library Folder from the selected folder.

Explore
This command opens a Windows Explorer window of the currently selected
folder, or the parent folder of the currently selected file in the Media Explorer.
This is a useful feature for quickly renaming or deleting files, since ACID Style’s
Media Explorer cannot perform these actions.

Refresh
This command updates the Media Explorer window to include any changes in
the drive or folder structure.
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Library Folder Shortcut Menu
The Library Folder shortcut menu is reached by right-clicking on a Library
Folder in the Media Explorer.The options on this shortcut menu are explained
below:

Remove Library Folder
This command removes the selected Library Folder from the Media Explorer.

Explore
This command opens a Windows Explorer window of the currently selected
folder, or the parent folder of the currently selected file in the Media Explorer.
This is a useful feature for quickly renaming or deleting files, since ACID Style’s
Media Explorer cannot perform these actions.

Refresh
This command updates the Media Explorer window to include any changes in
the drive or folder structure.

Meters Shortcut Menu
The Meters shortcut menu is displayed by right-clicking on the meter on the
right side of the Media Explorer page. The options on this shortcut menu are
explained below:

Reset Clip
This command resets the Clip Indication at the top of the meters, if it has been lit.

Meter Range
These options select the displayed level range of the meters. Choosing a wide
range allows you to see lower level signals at the expense of precision display
at high levels.

Show Labels
This option toggles the meter level labels on and off.
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Hold Peaks
When this option is selected, the highest peak levels are held on the meter with
a thin line.

Hold Valleys
When this option is selected, the lowest peak levels are held on the meter with
a thin line.
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Keyboard Shortcuts
ACID Style contains numerous keyboard shortcuts that make editing and
navigation faster.These keyboard shortcuts are listed below:

General
Press To

<Ctrl>+<N> New

<Ctrl>+<O> Open

<Ctrl>+<S> Save

<Alt>+<Enter> Properties

<Alt>+<F4> Exit

<Ctrl>+<Z> Undo (except in Media Explorer)

<Alt>+<Backspace> Undo (except in Media Explorer)

<Ctrl>+<Shift>+<Z> Redo

<F1> Help Contents and Index

<Shift>+<F1> Enable What’s This? Help

<Esc> Cancel operation

<Shift>+<F10> Display shortcut menu for whatever has focus
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Track View
Press To

<Ctrl>+<R> Record

<Ctrl>+<G> Go To

<Ctrl>+<A> Select All Events

<Ctrl>+<Shift>+<A> Unselect All Events

<M> Drop Marker

<T> Add Tempo Change

<K> Add Key Change

<Shift>+<T> Add Tempo and Key Change

<I> Set start of Loop Region to cursor position

<O> Set end of Loop Region to cursor position if later
than start, otherwise set start of Loop Region

<Ctrl>+<L> Set Loop Region to the size of the Track View.
Pressing again will toggle back to original
position

<Shift>+<L> Set Loop Region to the entire project. Pressing
again will toggle back to original position

Track List
Press To

Numpad - Pitch down 1 semitone

Numpad + Pitch up 1 semitone

<Ctrl> + Numpad - Pitch down 1 octave

<Ctrl>+Numpad + Pitch up 1 octave

<Shift>+Numpad - Pitch down 4 semitones (Windows NT only)

<Shift>+Numpad + Pitch up 4 semitones (Windows NT only)
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Press To

Numpad * Reset pitch

Left Arrow Decrease fader value

Right Arrow Increase fader value

Up Arrow Move Track selection up one Track

Down Arrow Move Track selection down one Track

<Shift>+Up or Down Arrow Multi-select Tracks

<Page Up> Move Track selection up one “page” of Tracks

<Page Down> Move Track selection down one “page” of Tracks

<Ctrl>+<A> Select all Tracks

<Ctrl>+<Shift>+<A> Unselect all Tracks

<Delete> Delete Track

<F2> Edit Track name

Event Editing
Press To

<Ctrl>+<X> Cut

<Shift>+<Delete> Cut

<Ctrl>+<C> Copy

<Ctrl>+<Insert> Copy

<Ctrl> +<V> Paste

<Shift>+<Insert> Paste

<Ctrl>+<Shift>+<V> Paste Insert

<Delete> Delete Events

<D> Cycle through edit tools

<Shift>+<D> Cycle backward through edit tools

<Ctrl>+<D> Select Draw tool

<J> Join selected Events
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Press To

<S> Split Event at cursor

Numpad - Pitch down 1 semitone

Numpad + Pitch up 1 semitone

<Ctrl>+Numpad - Pitch down 1 octave

<Ctrl>+Numpad + Pitch up 1 octave

<Shift>+Numpad - Pitch down 4 semitones (Windows NT only)

<Shift>+Numpad + Pitch up 4 semitones (Windows NT only)

Numpad * Reset pitch

<Shift> while dragging Temporarily disable Snap To
an event 

<F2> Display Properties page for Event

Playback
Press To

Space bar Play/Stop with focus in Track View

<Shift>+Space bar Play All/Pause with focus in Track View

<Ctrl>+<P> Play/Stop with focus anywhere

<Ctrl>+Space bar Play/Stop with focus anywhere

<Ctrl>+<Shift>+Space bar Play All with focus anywhere

<Enter> Pause

<Ctrl>+<Enter> Pause with focus anywhere

<L> Play Looped on/off
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Navigation
Press To

<Home> Move cursor to start of project

<End> Move cursor to end of project

<W> Move cursor to start of project

<E> Move cursor to end of project

Left or Right Arrow  Move cursor 1 pixel

<Ctrl>+Left or Right Arrow Move cursor to next or previous Marker. If no
Markers exist, go to Start or End of project

If Loop Region is Active:

<Home> Move cursor to start of Loop Region

<End> Move cursor to end of Loop Region

<W> Move cursor to start of Loop Region

<E> Move cursor to end of Loop Region

<Ctrl>+<Home> Move cursor to start of project

<Ctrl>+<End> Move cursor to end of project

When Snap To is disabled:

<Page Up> or <Page Down> Move cursor by small increments

<Ctrl>+<Page Up> or Move cursor by large increments
<Page Down>

<Page Up> or <Page Down> Move cursor by Beat Ruler markings
<Page Down>

<Ctrl>+<Page Up> or  Move cursor by 4 Beat Ruler markings

Number Keys (not Numpad) Move cursor to corresponding Marker
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Magnification and View
Press To

Up or Down Arrow Zoom time in/out small increments

<Ctrl>+Up or Down Arrow Zoom time in/out large increments

<Shift>+Up or Down Arrow Zoom Track height in/out small increments

<Ctrl>+<Shift>+ Zoom Track height in/out large increments
Up or Down Arrow

<F9> Zoom Normal

<Shift>+<F9> Zoom Edit

<Ctrl>+<F9> Zoom Overview

<Ctrl>+<Shift>+<F9> Zoom In Full

<F6> Switch focus through all parts of ACID Style
window

<Shift>+<F6> Switch focus backwards through all parts of
ACID Style window

<Ctrl>+<Tab> Cycle through Explorer and Properties pages

<Ctrl>+<Shift>+<Tab> Cycle backward through Explorer and Properties
pages

<C> Center cursor in Track View

<Ctrl>+<T> Focus to Track View

<Alt>+<0> Focus to Track View

<Alt>+<1> Display Media Explorer page

<Alt>+<2> Display Properties page

Miscellaneous
Press To

<F8> Enable or disable Snap To

<Ctrl>+<E> Explore current folder (in Media Explorer)
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Frequently Asked Questions

This section offers answers to some of the more frequently-asked questions
about ACID Style.

Why do my own Loops sometimes play a lot faster or slower
than I intended?
When a loop is not “ACIDized,” ACID Style has to make logical guesses about
the tempo of a file. Sometimes it will guess incorrectly. Usually if it does guess
incorrectly, it will guess that there are half as many beats in the file as there
really are.This kind of error will cause the loop to play twice as fast as it should.

To remedy this problem, click on the Track tab in the Properties page. Increase
or decrease the Number of beats control until the Loop plays at the correct
tempo. Disk-based Tracks can also exhibit this behavior. Adjust the Stretch from
tempo control to indicate the correct original tempo of the file.

Why do some of my Loops sound like they have been put
through an Echo effect?
You may be trying to slow down the tempo of a fast Loop too much.

ACID Style is really good at time compressing and expanding files, however, it
can’t work magic. A 140 bpm Loop is not going to sound very good at 90 bpm.
Extreme slow downs in tempo can create echo effects.

Why does my ACID Style project skip or gap during playback?
Skipping and gapping in the audio during playback can be caused by several
things. The most common cause is a lack of RAM. Most of the audio that you
deal with in ACID Style will be stored in RAM. If you open a lot of files, RAM
can be eaten up quickly. If too much of your physical RAM is being used,
Windows will start “swapping” out RAM to your hard drive. If this happens to
your Loops, ACID Style will most likely gap when it has to swap the audio back
into RAM.

There is a handy RAM usage meter at the bottom of the ACID Style window. If
the meter ever reaches the red stage, you might experience audio gapping.
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Another reason for audio gapping might be playing too many Disk-Based
Tracks at once. ACID Style is not optimized to play more than one or two
stretched Disk-Based Tracks at a time. Unstretched Disk-Based Tracks will
perform better, but will still top out at four or five, depending on your system
configuration.

If your CPU can’t keep up with all of the processing that is happening in real
time, you will have to cut back on the amount of real-time processing or
upgrade your CPU.
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A

Acidizing  10, 31

Adding Events  20

Adding files to project  16

Arranging Loops  8

Audio, monitoring  30

B

Beat ruler  19

C

Changing Tempo/Key  22

Channels  29

Configuring ACID Style  5

Copy button,Toolbar  13

Copying Events  24

Creating Libraries  17

Cut button,Toolbar  12

Cutting Events  24

D

DirectX Plug-In packs  38

Disk-based Tracks  10, 32

Draw Tool button,Toolbar  14

E

Editing  18
Editing Events  23
Editing Tracks  34

Erase Tool  36

Erase Tool button,Toolbar  14

Event properties  31

Event properties, modifying  33

Events
Adding  20
Copying  24
Cutting  24
Editing  23
Pasting  24

F

FAQ  71

Finding Loops  7

Fitting to time  47

G

Go to End button,Toolbar  14

Go to Start button,Toolbar  14

H

Help  12, 55

I

Installing ACID Style  3

K

Key control  22

Key, Changing  22, 37

Keyboard shortcuts  67

i n d e x
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L

Libraries, creating  17

Loop Tracks  9,32

Looped Playback  21

Loops
Acidizing  10
Arranging  8
Finding  7
Previewing  16, 17

M

Markers  38

Media Explorer  7, 11, 16

Modifying Event properties  33

Modifying Track properties  32

Monitoring audio  30

Monitoring signal level  30

Multi-function section  11

Muting a track  25, 26

N

New button,Toolbar  12

O

One-shot Tracks  10,32

Open button,Toolbar  12

Opening files  39

P

Paint Tool  35, 48

Paint Tool button,Toolbar  14

Pan, changing  26

Paste button,Toolbar  13

Pasting Events  24

Pause button,Toolbar  13

Play All button,Toolbar  13

Play button,Toolbar  13

Play Looped button,Toolbar  13

Playback  20
Looped  21

Playing your project  8

Preferences  53

Previewing Loops  16, 17

Properties page  11-12, 31-33

R

Record button,Toolbar  13

Recording  27

Redo button,Toolbar  13

Reference  39

Registering ACID Style  4

S

Sample rate  29

Sample size  29

Save button,Toolbar  12

Saving files   41

Select Tool  34

Select Tool button,Toolbar  14

Serial number  4

Shortcut menus  57

Shortcuts, keyboard  67

Signal level, monitoring  30

Silence, inserting  47

Snap to  37, 52

Snapping  37

Soloing a track  25, 26

Stop button,Toolbar  13

i n d e x
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Support,Technical  5

System requirements  3

T

Technical Support  5

Tempo slider  22

Tempo, Changing  22, 37

Time ruler  19

Time zoom controls  19

Toolbar  12

Toolbar, Customizing  15, 53

Tracks
editing  34
order  27
pan  26
reordering  27
types  9
volume  25
properties  31, 32

Track height zoom controls  20

Track List  11
editing in 25

Track View  8, 11, 18
editing in  18

Tutorial  2, 9

U

Undo button,Toolbar  13

V

Volume, changing   25

W

What’s This? button,Toolbar  14

Z

Zoom Tool  36

Zoom Tool button,Toolbar  14

i n d e x
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